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WinCap BASICS
Logging-on to WinCap
1) Open your browser, go to http://wincap.esboces.org.
If you have previously logged on to WinCap go to item 5 on page 5 and follow the
instructions.
If this is your first time accessing WinCap, you will be prompted to install the Citrix
application. Click the green “Install” button.
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2) Click “Run” in the information bar when you are asked if you would like to run the Citrix
Online Plugin executable.

3) The Citrix plugin will now install.
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4) You should see a successful installation notification.
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5) Within a few seconds you will be redirected to the WinCap portal login screen. Login with
your BOCES Network username and password.

6) Click on the WinCap icon to launch WinCap.
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The following Logon prompt will appear. Enter the WinCap User Name and Password that you
have been assigned by the System Manager.

Exiting/Logging-off WinCap
It is extremely important to exit the application correctly.
To exit the WinCap application and log-off the server:
A. Using your mouse:
1) Choose File from the WinCap menu bar.
2) Choose Exit.

The following message box will appear to confirm that the log-off from WinCap and the
Application Server is being done properly.
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General Navigation and Data Maintenance Functions
There are two basic means for accessing the features available within WinCap:
1) through the Menu Bar and the submenus/options presented underneath it
2) through toolbars that allow for the selection of specific features and options by clicking on
icons representing the available options

Menu Bar

The WinCap Menu Bar functions are similar to those found in other Microsoft Windows
applications. Users can select the appropriate options they need from this menu.

based

Main Menu options are selected by clicking on the option with the mouse, or by pressing the Alt
key and typing the letter that is underlined in the name of the option.
Submenu options are selected by clicking on the option, or by typing the letter that is underlined
in the name of the option.
Certain options can also be selected by using the Ctrl or Alt keys in combination with a specific
function key. For example:
Alt + F4
Ctrl + F4
Ctrl + F1
Ctrl + F10

Exit/Log-off application
Close window/Exit Form
Cycle through Windows
Close All Windows

The File menu is used to access administrative functions within WinCap and for overall system
operation. Details concerning these specific options are presented within the pertinent sections
of this manual.

The Form menu provides choices specific to the active form window. They deal with record
maintenance and with navigation among the records accessed through the specific form.
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The Edit menu provides options for action that can be taken on a field within a form or for a list
that is presented to select from. These options perform the same functions they do within other
windows applications.

The Manage menu is the primary menu for accessing the options for maintaining and processing
data within the specific functional components of the WinCap Accounting, Payroll and Human
Resource Management systems.
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The Report menu is the primary menu for accessing the reporting options available within the
specific functional components of the WinCap Accounting, Payroll and Human Resource
Management systems.

The Window menu provides options to assist the user in managing the form windows that are
open within WinCap at any particular time. In addition to the four standard options that are
listed on this menu, the user can also find a list of all the WinCap forms that are currently open at
the bottom of this menu. The check mark denotes the active form. Selecting another window
from the list will select that form as the active form window.
The Toolbars menu is used to activate or hide the toolbars available within WinCap. These
options function as toggles. When there is a checkmark next to the option, the specific toolbar
will be activated, otherwise it will be hidden.
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Toolbars
Toolbars provide a shortcut method to select options available within WinCap. Instead of having
to click on the Main Menu Bar and the various levels of submenus, desired options can be
directly selected by clicking on an icon found on the toolbar. WinCap provides three different
toolbars:
1) A system-defined Form Toolbar with icons representing the options found on the Form
Menu off the Main Menu Bar
2) A user-defined Application Toolbar to select the various data maintenance Forms and
processes that the user uses most often
3) A user-defined Report Toolbar to select the various reports the user generates most often

Form Toolbar
This toolbar provides icons to assist the user in accessing, maintaining and displaying data
records through WinCap Forms. It is a system-supplied toolbar and cannot be modified by the
user. It includes the same options as are found on the Form Menu. If this toolbar does not
appear in the WinCap application window, it can be activated by selecting it from the Toolbar
Menu off of the Main Menu Bar.

This toolbar provides options for action to be taken for the active WinCap Form.

Record Maintenance Icons
Fiscal Year – Click on this drop down to change the fiscal year associated
with the active form window.

Add - Select this option to add a new record based on the active form window.
Add Similar - This option will add a record by initially copying the current record
displayed in the active form window. Key fields that must be unique will be blanked out
for the new record, so the user or system can assign a different key value for the new
record.
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Modify – Where permitted; select this option to edit data in the active form.
Save - This option will save, or post, the information entered for a new record or the
modifications made to an existing record.
Undo - This option restores data back to the status before the transaction began. For
Add, it will re-initialize the form; for Modify it will restore the values of all fields to
those last saved.
Print - This icon will default the printing of a specific report associated with the form.
For certain forms, right-clicking will default the printing of that report for the specific
record displayed in the form window. (i.e. for PO Maintenance form, left-clicking this
icon brings up the PO printing specification dialog box; right-clicking will automatically
specify the printing of the purchase order record displayed.)
Delete – Where permitted, this option will delete the record displayed in the active form
window. If conditions exist that restrict the users’ ability to delete the record, then an
appropriate message will be displayed.
Navigation Icons—Assist the users in accessing and displaying specific record(s)
Go To – Provides a prompt to enter the exact value for a record that the user wishes to
display in the active form window.
Find – Use this option when the exact ID code (PO#, Transaction #, etc) for a record
you wish to display is not known. It will provide a list of records in the file that meet
specified criteria from which the user can then select the record they wish to display.
Record Order– This combo box allows the user to select the field to use as the basis for
ordering the records accessed through the Form.

Record Advancement Icons - Based upon the data order selected, the following icons are used
to move through the records accessed through the active Form.
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First Record -

will access the "First" record in the file.

Previous Record -

will access the "Previous" record in the file.

Next Record -

will access the "Next" record in the file.

Last Record -

will access the "Last" record in the file.

Filter – Left-click to display a dialog for setting a filter to restrict the records selected for
the active form window. Once the filter has been set, the icon will display in yellow
and right-clicking on the icon will provide the following menu of options:

Selecting “Display Record Detail” provides a dialog displaying the filtered record count.

Informational and Other Icons
Provides history information for the record on display in the active form window.
Minimally, it will show the date and time that the record was added and the user that
added it, and the date and time that the record was last updated and the user that updated
it. For certain forms, the history provided will be more in-depth (i.e. for the PO form, it
displays the full approval and printing history of the order)

Notes - Used to access a text box for entering and viewing notes related to the specific
record displayed in the active form window. To add a note, the user must be in add, add
similar or modify mode. If a note is present, the icon will appear as

.

This icon will access an on-line help feature, currently in development.
Exit - This option will close the active form window. If the current record is in the Add
WinCap Basics – Updated April, 2013

12 of 22

,

or Modify mode at the time this option is selected, it will present the standard prompt
whether to save the changes or not. If cancel is selected, it will return to the active
record.
Note: Icons on the Form Toolbar will appear as inactive (pale gray) if the options are
inappropriate given the status of the record in the active form window, or if the user’s security
does not permit them to perform that operation.
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WinCap Terminology & Conventions
As WinCap has been developed under the Microsoft Windows operating system, it generally
uses the standard features and conventions found within most Windows applications. This
section provides a general review of the basic WinCap standards and conventions, so that users
can become familiar with the terminology that is used throughout this manual and other WinCap
documentation.

Types of Windows
There are two distinct types of Windows that are opened within the WinCap application:
Form Windows that are used to maintain or display data within the various functional
subsystems or modules of WinCap. These will be referred to as Forms.
Dialog Boxes that assist in executing a process or procedure, or provide the user with messages
relative to a specific procedure. These will be referred to as Dialogs.
Forms
Forms are used to display or modify existing data records, or to add new records to the system.
Some forms contain more information than will fit within a single window, and they employ
page tabs to provide a logical separation of the data managed through that form. In the example
below, basic information about the position that is required for payroll is maintained on the
Payroll page. Additional information for human resource management functions is maintained
on the Human Resources page. To switch to another page of information, simply click on the
specific page tab, or use the right or left cursor arrows on the keyboard when on a page tab.

WinCap Basics – Updated April, 2013

14 of 22

More than one form window can be open at the same time within WinCap. In fact, more than
one copy of the same form can be open concurrently. This allows the user to view two different
records in the same file concurrently, or to display and work with data from two different fiscal
years at the same time.
Dialogs
Dialog windows are not used to maintain data, but are instead designed to provide the user with
messages or prompts for information pertinent to a particular process or procedure. Once a
dialog box is opened, it must be concluded by selecting one of the command options provided at
the bottom of the dialog box. It is not possible to select another option within WinCap or move
to an open form until the dialog has been responded to by selecting one of the commands.
The first example is a typical WinCap report dialog. The user is provided with options for
selecting the records to be processed in the report and for sorting, breaking, and totaling.
Selecting OK will execute the report, or Cancel will abort. Until either option is selected, the
user will be prevented from accessing any other WinCap options or forms.

The following is an example of a simple message dialog that provides the user with information
or instructions relevant to the current task they are performing. In this case, the user tried to save
the record without certain required information.
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Command options can be selected by clicking on them with the mouse or by simultaneously
pressing the Alt key and the letter that is underlined on the command button. The Enter key will
also select the active command button (denoted by a dotted line within the command button, as is
the case for the OK button below). The Esc key can also be used in place of the Cancel button.

It is generally recommended that users use the Tab key or their cursor arrow keys to move
between fields or text boxes, or to use their mouse to click into a field, rather than using the
Enter key. In dialogs, the OK button is usually initialized for execution. Pressing the Enter key
would possibly cause the routine to execute before the user is actually done responding to the
dialog prompts.

Entering Data/Responding to Prompts in Forms and Dialogs
The following are the typical means of entering data through the WinCap Forms, and for
responding to prompts within Dialogs.
As in other applications, most data is entered through the standard Text Box. Enter the
alpha/numeric data via the keyboard. Also, all of the standard Windows options for editing the
contents of a text box are available within WinCap, including the options to copy and paste
values (use the Edit Menu from the Main Menu Bar or the standard hotkeys noted there.)
In the following example, left clicking on the magnifying glass next to the Vendor field
initializes the Vendor Search. If a record is selected from the Vendor table, the corresponding
Vendor Id will automatically be entered into the text box.
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A Drop Down List Box, or Combo Box, presents a list of choices to the user that are available
for a specific field or procedure. There is usually a default selection that appears in the box. To
display all of the choices, click on the down arrow or press the space bar. If there are too many
selections to appear in the menu box presented, a vertical scroll bar will be present to indicate
there are more values than are displayed. When the choice is selected the menu box disappears
and that selection is displayed in the List Box.

A Check Box functions like a toggle to indicate the response to that option—Yes if checked, No
if blank. If there is a check mark in the box already, clicking it again will remove it. When a list
of choices is presented via check boxes, then more than one choice may be selected, as in the
example below.

Radio Buttons are another means of presenting options, but where only one choice is allowed.
When clicked, a dot is placed inside the circle of the option chosen. If another option is
subsequently chosen, the one previously selected will be toggled off, or deselected. This
following example has two options to select from, but there could be more than two choices. In
this case, the user has opted to specify a pay period rather than a range of payroll dates for
selecting records to be processed in a report.

Grids
Grids are used to display a list of records within a form or dialog. Data is presented in much the
same way as it is in a spreadsheet. Records are listed in rows and data fields are presented in
columns.
In the first example below, a grid is used within the Employee Maintenance form to display and
manage all of that employee’s positions for the 2001 Fiscal Year. The rows of the grid are the
individual positions. Specific information for each position is displayed in the columns of the
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grid. Data is also presented field-by-field in the form below the grid for the specific position that
is selected (as indicated by the > in the left-most column of the grid). To select and display the
information for the second position, simply click on that record in the grid.
Example 1—Grid within a form

Clicking on the second position record displays data for that position

In the second example, a grid is utilized within a dialog used for searching and selecting vendors
from the vendor file. See Find in Record Maintenance Icons for more information regarding
this type of dialog.
Example 2—Grid within a dialog
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Regardless of whether a grid is within a form or a dialog, the user is able to customize the grid
settings.
To adjust the width of a column within the grid, left-click the mouse in the yellow header line, on
the right vertical column rule of the specific column the needs to be adjusted. A set of cross hairs
will appear if the cursor is positioned properly. Drag the column to the desired position (to the
left to make it narrower, to the right to make it wider). In the example below, to make the City
column wider, click in the header on the vertical rule indicated and drag the mouse to the right.

To adjust the order or location of the columns within the grid, left-click the mouse on the field
name in the header line and drag the column to the desired position and release the mouse. The
other columns will shift automatically to adjust for the placement of the column where it is
dropped. In the example below, the ID field has been dragged and placed on the right side of the
grid from its original location.
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In the third example below, split bars have been added to grids to allow users to keep designated
information static on either side of the grid. To split a grid, click and drag the split bar graphic to
the area on the grid where it will be docked. The split bar graphic is circled in the example
below. Notice even when the grid is split, the Type field appears on both sides of the bar. This is
true for all fields; they all show on both sides.
Example 3—Split Grid Bars
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To restore a customized grid back to the system defaults, click in the small box in the upper-left
corner of the grid (usually magenta or light purple in color), and select the option to "Reset to
system default". Unless the option to save the customized grid setting was selected, or it was set
as the user’s default, the grid will revert to the system default the next time the form or dialog is
opened.

Each user is also able to save any number of different customized settings for every grid in the
system, and to designate one of them as their default setting whenever the form or dialog is
opened that displays that grid. Please refer to Saved Settings for Criteria, standard system
procedures for saving these customized settings.
NOTE: Rearranging and resizing the columns within a grid may result in the magenta color
disappearing. This does not limit the functionality described, and the user may still click in the
box to display the options shown above.
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Use of Colors
Within the WinCap application colors are often used to provide a visual indicator to lend
significance to the data so designated. The following are a few of the standards utilized
throughout WinCap:
Fiscal Year:

White background denotes the current Fiscal Year, based on today’s date
Red background denotes a previous Fiscal Year, based on today’s date
Yellow indicates the next Fiscal Year, based on today’s date

Negative numbers are always shown in red
Inactive accounts are shown in Yellow
Invalid accounts are shown in red—this would include accounts that have been inactivated and
that the specific user is not able to transact against
For fields that reference tables, the description displays in red if the table value entered is invalid,
either because it does not exist in the table or that value has been inactivated.
Aqua is generally used to note that there is additional data not currently displayed that the user
might want to look at. For instance, if data is maintained in a memo field and a grid only
displays the first line of text, that entry will generally be shown in aqua. Often, double-clicking
that entry will display the rest of the memo field or other detailed data. For certain table lookups, the field will be highlighted in aqua to indicate there is more than one possible value in the
table and that the user might want to look at these before accepting a default. Aqua is also used
to note other variations from the norm.
Within each chapter of this manual dealing with the functional components of WinCap, the use
of colors will be further discussed as they are applied within that subsystem or module.
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